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FileNet Document Publisher Creating a WML project
Creating a WML project

FileNet Document Publisher Station can operate in two modes: HTML and WML. In 
WML mode, you can create web publications consisting of WML output that can be 
published to a WAP server for accessing via an Internet-enabled device.

Document Publisher Station opens in HTML mode by default, but you can switch 
back and forth between HTML and WML mode.

HTML projects use a copy of the default project file Default.tcp. WML projects use a 
copy of DefaultWML.tcp, which is designed specially for WML projects. Both project 
files are located in the ...\Resources\en folder of your FileNet Document Publisher 
directory. Copies are also available in the Support folder on your product disc.

Notes: 

WML publications created in Document Publisher Station use templates that 
target the Nokia micro browsers (which support WML standards 1.1 and 1.2) 
and the Phone.com micro browser. Other micro browsers may produce 
unexpected results.

We recommend that you do not add HTML or XML source documents to a 
WML project, as this will not produce valid WML.

The Help topics you view when you click the Help buttons in Document 
Publisher Station are designed for HTML projects and should be used only as a 
guide when you are creating WML projects. 

Entering the WML mode
 1.  To enter the WML mode, click Application Options on the View menu.

 2.  Click the Dialogs tab.
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Figure 1-1  The default settings for the Dialogs tab dialog in Application Options. Once you select 
Show Project Type selection dialog, the Project Type dialog box will open the next time you start a 
new project. You can then switch to the WML mode to create WML projects. 

 3.  Select Show Project Type selection dialog.

 4.  Click OK.

You are now ready to start a WML project.

Starting a new WML project

 1.  Click New  on the standard toolbar to start a new project. The New 
Project Type dialog box opens.

 2.  Select Create a WML Project. 

You can also select Don’t show this dialog again if you plan to stay in the 
WML mode. If you do, when you’re ready to return to the HTML mode, you can 
return to the Applications Options dialog box (Figure 1-1) and select Show 
Project Type selection dialog once again. (Clicking Don’t show this dialog 
clears the Show Project Type selection dialog check box in Application 
Options.)

 3.  Click OK to close the New Project Type dialog box. 

You have opened a copy of DefaultWML.tcp. You will see <Unnamed-WML> in 
the root of the publication hierarchy and also as the default publication name in 
the Publication Properties dialog box, which has already opened. 

 4.  You can rename the publication. Select <Unnamed-WML> and type 
WMLProject. Then click OK. 

You are now in the WML mode, ready to start your WML project. The 
differences between the HTML and WML modes may not be immediately 
apparent. 

On the main window, one difference is that the Layout button  on the 
toolbar is disabled. (You cannot create a frameset, table or custom table layout 
for a WML publication.) Note, also, the special icon next to the root publication 
in the Publication Hierarchy pane. As soon as you open any project in 
Document Publisher Station, you can check the publication icon to identify the 
project type. 

Once you add a document to the project, you will quickly see other differences.
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 1.  Click Add Document  on the toolbar and select SourceDocWML.doc 
from the ..\Samples\en\Formatted folder. The Choose Template dialog box 
opens.

Figure 1-2  There are only three default templates available for the cards (pages) of a WML project. 
These templates relate to the specific micro browser that will be used to view the WML output.

First, you can see that there are only three default templates available for cards 
(pages) in a WML project. You can select each of the templates, in turn, but 
you will not see many differences in the Preview window. (Obviously, you can 
still create new templates, basing them on the default ones.)

Each template supports a different micro browser. The essential difference 
between Nokia 1.1 and Nokia 1.2, for example, is that the latter (which 
supports WML standard 1.2) permits use of the <pre> tag for pre-formatted 
text. (There was also attribute changes between 1.1 and 1.2.) Your choice of 
template will depend on the device you want to support. 

 2.  Select Nokia (WAP 1.1).

 3.  Click OK to close Choose Templates and return to the main window.

Let us explore the standard features in Document Publisher Station to see the 
differences between a WML and HTML project. Remember: many of the features 
you are used to in HTML are simply not available in WML, which is a much simpler 
format.

Application and project options
Let us begin with a quick review of application and project options. The Application 
Options dialog box (open from the View menu) is essentially the same whether you 
are in an HTML project or a WML one. However, in addition to the new option in the 
Dialogs tab dialog for toggling between the two modes (see Figure 1-1), the Default 
Output Extensions panel in the General tab dialog now includes the wml extension, 
which is used by default for all documents added to a WML project (see Figure 1-3).
7
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Figure 1-3  The wml extension is used by default for all WML projects. Like the htm extension for 
HTML projects, you can change this, if you want. 

The Project Options dialog box (also from the View menu) displays a greater number 
of differences when in the WML mode. Gone are the following panels and their 
options: HTML Generation, Containing Frame Name (there are no frames in WML 
publications), and Print Publishing (you do not print from an Internet-enabled 
device).

Element Setup
The Element Setup property sheet is usually your first stop when creating any new 
project. It is usually best to check elements, styles, patterns, and metadata, and to 
create new elements and map your content, as appropriate, before you begin to 
format output, set navigation links, and so on.

Figure 1-4  There are fewer default elements in a WML project.
8
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There are fewer default elements in a WML project and no default ranks, styles, 
patterns, or metadata. But you can still use ranks, styles, patterns, and metadata in 
your WML project, just as you would in an HTML one. (No styles or patterns are 
shown here because the source document SourceDocWML.doc is a manually 
formatted document—all the content is assigned to the Normal style—and the 
document was imported with the default None selected in the Choose Template 
dialog box. As a result, all of the content was mapped to the Default Paragraph 
element.) 

With one other exception, the options available in an HTML project are available for 
WML, too. That exception is the absence of a Page TOC, which you cannot create or 
promote elements to. (To check this, select an element and click Properties. On the 
General tab dialog you will see that the Include in Page TOC check box is disabled.)

Formatting
The Formatting property sheet is significantly different for a WML project. Many of 
the HTML features and settings are simply not relevant in WML. Figure 1-5 shows 
the reduced number of tab dialogs available. Moreover, there are fewer settings and 
options available in these tab dialogs.

Let us walk through each tab dialog, in turn.

Character — For WML output, there are no font or font size options, and CSS 
(cascading style sheets) is not an option. (WML output is obviously very plain, and 
the font and font size are governed by your micro browser.) You can still have bold 
and italic text, for example, but there are fewer text effects available. As you can 
see (Figure 1-5), Table Overrides is still an option, but your micro browser may not 
support tables. 

Paragraph — Here, your only choice is alignment. 

Tables — You have similar functionality as for HTML projects, but your micro 
browser may not support tables.
9
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Figure 1-5  Formatting has fewer tab dialogs available for WML projects, and fewer options in the 
tab dialogs that are available.

Graphics — Note the option to convert to WBMP for an Internet-enabled device. 
This is the default conversion format when you create a WML project. Three 
graphics formats—WBMP, BMP, and GIF—can, in fact, be used for WML 
publications. However, not all WAP-enabled devices support WBMP, and the micro 
browsers that are targeted by the three default templates do not support a common 
graphics format. Of course, you must work with much smaller-sized graphics files in 
a WML project (just as your source documents need to be smaller, too). 

WML — Here, you can insert WML or scripting code before or after the content 
associated with the selected element (just as you might insert HTML code in the 
case of an HTML project).
10
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Navigation
There are significant differences between setting up navigation for a WML project 
versus an HTML project. Figure 1-6 shows the complete set of options available for 
your WML project.

Figure 1-6  Navigation links for a card (page).

The order of selected links is very important. (The same links are available when you 
open this dialog box for a reference page.) 

Keys to navigation
To permit navigation through your WML publication, you can assign some of the 
links shown in Figure 1-6 (you are unlikely to want to assign all of them). The links 
you select will be assigned to the two unmarked buttons on your device (which we 
will refer to as the “left blank button” and “right blank button”). How these buttons 
are used, by default, varies between devices. (For the Phone.com micro browser, for 
example, the left blank button is used for the Accept or OK command.) By selecting 
navigation links here, you can override the default settings.

Some pointers:

The first navigation link you select in Navigation (Figure 1-6) will be assigned to 
the left blank button. All others you select will be assigned to the right blank 
button.

If you select three or more navigation links in total, the two or more links that 
are assigned to the right blank button will appear in a menu in the browser 
window when you click that button.

However, if your TOC, say, has only one card (page), the Next Page link would 
be redundant. In that event, if you assign the Next Page link, it would drop out 
completely and the next navigation link you selected would take its place. 

Likewise, a Previous Page link has no meaning if there is no previous page. So 
if you are on the first card (page) of a document, the Previous command (link) 
would not be available. However, it would be available for all successive pages 
you scroll to.

The order of the link types in Navigation is therefore important.
11
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You can use drag-and-drop to change the default order of the links shown in 
Figure 1-6. Simply left-click the link type you want to move, and, with the 
mouse button held down, move the link type up or down the list to reposition it 
wherever you want it to be. Figure 1-7 shows some of the links moved to 
create a new order.

Note: The assignment of navigation links, as described above, assumes that you are 
targeting a device that allows for the assignment of links in this fashion. On a Nokia 
device, for example, all links will appear together on a separate card.

Figure 1-7  Navigation links for a WMLproject.

Note that some links have been dragged to the top of the list of links. The key thing 
is the order in which the selected links appear on the list. With this selection, Next 
Page will be assigned to the left blank button and the other three to the right blank 
button of the device. 

Note: The Link Text column (Figure 1-6 and Figure 1-7). You can edit this, if you 
want. Select the link type you want to edit, click the Properties button, and in the 
Link Properties dialog box, enter the text you want to use. Obviously, a character 
limit will dictate how long the link text can be (which, again, varies with micro 
browsers). 

Globals
In Globals, again we are working with a reduced number of tab dialogs, and fewer 
options in some of the tab dialogs that are available. 

Titles — Practically unchanged for WML projects (the page component option is not 
available).

Head — Include WML at Top of File (see Figure 1-8) displays the WML declaration 
for the template that you selected for your project (and therefore the micro browser 
you are targeting). 

Note: Most devices and emulators will not display content if the declaration is 
missing. However, you can edit the declaration in the event that a new DTD is issued 
and you want to supply it to your users. 
12
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The Include WML Before the First <card> Tag entry contains the “prev” reference 
that enables the Back button on Internet-enabled devices. You generally should not 
change this entry.

Figure 1-8  Globals for a WML project.

The WML declaration (in the top window) is required for your WML output to 
display in a micro browser. The <prev> reference in the bottom window is generally 
required or the Back button of your device may not work.

Card — This is the same as for an HTML project (where the tab dialog is named 
Body). Here, you can create event handles for a card in your WML output. 

Note: In the WML standard, a deck (or file) can contain one or more cards. In 
Document Publisher Station, however, the default templates all treat one card as 
being equal to one page. So in Document Publisher Station, a deck is the same as a 
file is the same as a card is the same as a page. 

Options — What is new here—and is a key ingredient in the creation of WML 
publications—is the Maximum WML File Size. This setting influences the eventual 
size of your uncompressed WML output. The default is 1397 bytes for each file 
(card), but you can change this number. See the next section. 

Note: The Options tab differs slightly for reference page. (See “Adding a reference 
page” on page 16.)

WML — This is essentially the same as the HTML version.

Layout — There are more limited options here, because inevitably you have fewer 
layout elements in a WML publication.

A word about file size
Each device has certain memory constraints. You must carefully control your WML 
output if it is to display successfully in an Internet-enabled device. 
13
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In fact, if an individual file is greater than 1397 bytes (compressed), it will not 
display. It’s important to understand the following:

When Document Publisher Station translates your project, it generates 
uncompressed WML files.

The size of these uncompressed WML files is controlled by the following setting in 
the Options tab dialog of Globals:

The default WML file size is 1397 bytes. (This value is simply the lowest 
common denominator for devices that use a compiled deck. It may be quite 
conservative in some instances.)

Document Publisher Station first splits an output file based on the element you 
select (the default is Heading 1). It then examines each output page to 
determine whether it is over the 1397 byte limit. If it is, Document Publisher 
Station splits the file again, to ensure that no output WML file is greater than 
the byte-size limit you set.

If Document Publisher Station splits a file to meet the 1397 file size maximum, 
it tries to do so at a space character—but may not succeed. As a result, a file 
may be split in the middle of a word (and most certainly in the middle of a 
sentence). This suggests the need to severely “chunk” your source content to 
make it suitable for WML publishing.

Once your WML output is published to a WAP server, it must then pass 
through a WAP gateway in order for it to reach an Internet-enabled device. The 
WAP gateway compresses the WML files. 

It is these compressed files that must be no larger than 1397 bytes (otherwise, 
the micro browser will not display them).

Suppose the WML files that Document Publisher Station generates compress 
to 200 bytes. This would leave about 1197 bytes available to the device that 
you are targeting. (As already noted, the default 1397 byte size may be 
conservative.)

In other words, conceivably you could set the file size limit in the Options tab 
to be much greater than 1397 bytes (say, 3000 bytes) and still be successful 
publishing to your target audience. The only thing to do is test, test, test. Try 
translating with different byte-size settings and see how successful your 
publishing efforts are. (This is something you obviously can’t test on an 
emulator.) 

You may note that your translated WML output may contain certain 
placeholder comments that cause the file size to be exceeded. During 
publishing, these comments are removed, thereby meeting the file size 
constraint.

Translating a simple project
Typically, you will want to test all your WML output before you publish it to a WAP 
server and make your content available to your users. Consider using an emulator. 
The one shown here was obtained from www.openwave.com.

Note: View the behavior of your WML publication in an emulator simply as a guide. 
In fact, you should generally expect to encounter different behavior between an 
14
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emulator and the Internet-enabled phone it is designed to emulate. For example, 
some emulators do not like spaces in folder or file names (though this is unlikely to 
be a problem with the device itself). You need to test thoroughly. 

 1.  With WMLProject.tcp open in Document Publisher Station, click Translate 

 on the toolbar. 

 2.  Click View  . What you will see in your browser, of course, is the same 
WML markup you saw in the Preview window of the Choose Template dialog 
box when you added the source document to the project (see Figure 1-2). 

However, with your emulator installed and running, you can easily view the real 
WML output in the micro browser. Let us say your translated output resides in 
C:\Document\WMLTest. The first output file will be SourceDocWML.wml (you 
will have several output files because of the default splitting and the restriction 
on WML file size).

 3.  In the Go field of your emulator, type:

File://C:/Document/WMLTest/SourceDocWML.wml (note the forward 
slashes).

 4.  Press Enter. 

Your WML output will display in the micro browser, as shown in Figure 1-9.

Figure 1-9  By typing “File://” plus the path for your output WML file on your hard drive in the Go 
field, you can view your WML output in your micro browser.

That is one simple test. Once you add a reference page, you can explore some 
additional features.
15
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Adding a reference page
 1.  With WMLProject.tcp still open in Document Publisher Station, click Add 

Reference Page  on the standard toolbar to open the Add Reference 
Page dialog box (Figure 1-10). 

 2.  Under Type, accept the default, Table of Contents.

Note: The Index reference page is not available for WML. Remember, too, that 
the TOC, LOF, and LOT templates are actually the same template. You can 
create a TOC with either one. (Three options are available to allow you to build 
different kinds of reference pages for the same project.)

Figure 1-10  The Index template is not available for WML projects. You can use Default TOC, but you 
will have to add a declaration to this template for your published reference page to be viewable. 

 3.  From the Templates drop-down list, select Nokia TOC (WAP 1.1). This 
reference page template is designed as a companion to the Nokia (WAP 1.1) 
template that you associated with the source document for cards (pages).

In addition to a companion TOC template for each of the templates used for 
cards (pages), there is also a Default TOC template available. This might be 
used for targeting other micro browsers. However, it does not contain a WML 
declaration (you can check the Head tab dialog of Globals to confirm this), and 
most emulators and devices will not display any content if the declaration is 
missing. In order to use Default TOC, therefore, you would have to add a 
declaration.

 4.  Click OK to return to the main window. 

 5.  In the Contents pane, double-click Table of Contents.wml (with a pause 
between clicks) and change the name of the output file to 
TableofContents.wml. 

This is necessary here because the emulator we are using does not like spaces 
in folder and file names (and will not display the page, as a result). It may not 
be necessary with other emulators and it will not be an issue with any Internet-
enabled device you target.

 6.  Click Translate  . 
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 7.  In the Go field of the emulator, enter:

File://C:/Document/WMLTest/TableofContents.wml

You should now see a very simple table of contents for your WML publication, 
with a single jump to take you to first card (page) of your main WML output, 
SourceDocWML.wml. 

You might care to experiment now by adding navigation links to both the Table of 
Contents.wml and SourceDocWML.wml. Experiment with the various links available 
and see how they behave in the emulator that you are using. 

Here is one last thing to note:

 1.  Select TableofContents.wml in the Contents pane and click Globals  on 
the toolbar.

 2.  Click Options to open that tab dialog. Note the panel at the bottom of the tab 
dialog (available only when a reference page is selected).

This setting is used to determine the linking mechanism for navigating between 
the TOC and your other content. It is yet one more instance where micro 
browsers vary. The <a href> option is designed for Nokia micro browsers (and 
is selected by default when you choose a Nokia reference page). The 
alternative <select> is suitable for Phone.com micro browsers (and becomes 
the default when you use the Phone.com reference page).

The big picture
Here are some key points to bear in mind as you begin to create and test WML 
publications in Document Publisher Station:

Test everything thoroughly. Emulators, devices, and micro browsers vary widely 
in how they interpret WML markup. 

Depending on your target audience and the number of micro browsers you are 
seeking to satisfy, you may need to create a project with multiple publications 
with the same content in each publication but a different template (for a 
different micro browser) associated with the content.

The WML declaration (see the Head tab dialog of Globals) is important, 
because it defines the “flavor” of WML being targeted.

The usability of TOCs varies greatly, depending on the linking mechanism that 
is employed (see previous section).

The <prev> tag should always be defined (see the Head tab dialog of Globals). 
On some devices, the Back button will not work without it.

The file size constraint (the default is 1397 bytes) applies to compressed WML 
output after you publish. You may be able to set the maximum size much 
higher.
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